
ВВЕДЕНИЕ

Архитектуры ARM Cortex�M0 и

Cortex�M3 сегодня лидируют среди

универсальных 32�разрядных про�

цессорных ядер микроконтроллеров

(МК). Свои изделия, имеющие ука�

занные архитектуры, продвигают

на рынок многие известные произво�

дители МК. По оценкам ряда экспер�

тов, в авангарде этого процесса на�

ходится корпорация NXP Semicon�

ductors, предлагающая потребителям

семейство своих МК LPC11xx с архи�

тектурой ARM Cortex�M0, а также се�

мейства LPC13xx и LPC17xx [3] с ар�

хитектурой ARM Cortex�M3.

Разработка и отладка приложе�

н и й н а б а з е 3 2 � р а з р я д н ы х М К

LPC11xx/13xx/17xx от NXP поддержи�

вается различными инструментальны�

ми средствами [1], наиболее известные

образцы которых традиционно пред�

лагаются на рынке компаниями – ли�

дерами в этой области – Keil Software и

IAR Systems. Это – программные паке�

ты IDE μVision4 и IDE IAR EWARM, вклю�

чающие среды разработки и отладки,

компиляторы, компоновщики, ассем�

блеры и т. д. Эти же фирмы выпуска�

ют и аппаратные средства разработки

и отладки (отладочные платы, аппа�

ратные отладчики – программато�

ры и т.п.) с поддержкой МК серий

LPC11xx/13xx/17xx.

Вместе с тем, компания NXP в парт�

нёрстве с фирмами Code Red Tech�

nologies и Embedded Artists предлага�

ет на рынке оригинальный инстру�

ментарий разработки и отладки

приложений на базе МК семейств

LPC11xx/13xx/17xx – аппаратно�про�
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граммную платформу LPCXpresso™.

Платформа состоит из программ�

ной части – интегрированной среды

LPCXpresso IDE, построенной на базе

графической среды Eclipse, и аппарат�

ной части – недорогих отладочных

наборов, состоящих из демонстраци�

онной платы с МК целевой системы и

интегрированного аппаратного отлад�

чика USB�JTAG/SWD.

По мнению автора, инструмента�

рий LPCXpresso является полноцен�

ной альтернативой продуктам от IAR

и Keil. Для такого мнения имеются

следующие основания. Стоимость де�

монстрационных плат LPCXpresso

примерно на порядок ниже стоимос�

ти отладочных плат с аналогичными

МК от фирм IAR и Keil, а предлагаемая

NXP идеология разработки прило�

жений с использованием этих плат

(см. ниже) обеспечивает значительно

большую гибкость и универсальность.

То же самое можно сказать о срав�

нительной стоимости других аппа�

ратных инструментальных средств,

прежде всего, отладчиков�программа�

торов (USB�JTAG�адаптеров). В инст�

рументарии LPCXpresso такой отлад�

чик (LPC�Link) уже интегрирован в

состав платы. Для использования

инструментария от IAR и Keil отлад�

чики (например, J�Link или ULINK2)

необходимо приобретать отдельно.

Справедливости ради заметим, что

LPC�Link существенно уступает упо�

мянутым отладчикам по скорости,

набору поддерживаемых функций

программирования, отладки и трас�

сировки, а также номенклатуре под�

держиваемых МК [3].

Даже в своем базовом (бесплатном)

варианте после инсталляции и пер�

вичной активации интегрированная

среда разработки�отладки LPCXpresso

IDE поддерживает максимальный

размер загружаемого в память МК

кода, равный 128 Кб, чем выгодно

отличается от бесплатных версий

(без ограничения времени исполь�

зования) IDE μVision4 и IDE IAR

EWARM (32 Кб). Стоимость обновле�

ний LPCXpresso IDE, позволяющих

увеличить максимальный размер

загружаемого кода до 256/512 Кб,

примерно на порядок ниже стоимос�

ти профессиональных (платных)

версий IDE μVision4 и IDE IAR EWARM.

При этом возможности, предостав�

ляемые LPCXpresso IDE разработчику

в плане создания, редактирования,

компиляции исходного текста на C

(с оптимизацией или без), компонов�

ки проектов встраиваемых программ

и загрузки их кода в МК, ненамного

уступают возможностям, обеспечи�

ваемым средами IDE μVision4 и IDE

IAR EWARM.

ИДЕОЛОГИЯ ПРИМЕНЕНИЯ

ИНСТРУМЕНТАРИЯ

LPCXPRESSO

Идеология применения инструмен�

тария LPCXpresso, по замыслу произ�

водителей, предполагает три стадии

разработки приложения.

На стадии оценки (evaluation) воз�

можности ЦП и периферии предва�

рительно выбранного для целевой

системы МК могут быть оценены и

протестированы разработчиком с по�

мощью простой демонстрационной

платы, на которой установлен этот МК

с минимальной аппаратной обвязкой

(кварцевый резонатор/генератор и

несколько дискретных элементов).

Отличительная особенность этой пла�

ты заключается в том, что на её кон�

тактные площадки (под две линейки

штыревых разъёмов) выведены все
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выводы МК, что обеспечивает под�

держку любых возможных подключе�

ний. В состав платы интегрирован

USB�JTAG/SWD�отладчик LPC�Link,

получающий питание от порта USB

управляющего компьютера и, в свою

очередь, обеспечивающий питание

целевого МК. Внешний вид оце�

ночной платы LPCXpresso для МК

LPX1768 с интегрированным USB�

JTAG/SWD�отладчиком LPC�Link пока�

зан на рисунке 1.

На стадии исследования (explore)

выбранной концепции приложения

разработчик может использовать

т.н. базовую отладочную плату (Base

Board), например, от фирмы Embed�

ded Artists, обеспечивающую поддерж�

ку максимального числа устройств

ввода�вывода и периферийных интер�

фейсов МК. Демонстрационная плата

может быть установлена на отладоч�

ную плату в две линейки разъёмов по

типу мезонина, как показано на ри�

сунке 2.

Вместе с тем, использование базовой

отладочной платы для построения ко�

нечной целевой системы может ока�

заться экономически неоправданным

из�за наличия элементов, не использу�

емых в конкретной системе. В этом

случае вместо отладочной платы мо�

жет быть использована т.н. плата про�

тотипа (Prototype Board), представляю�

щая собой по сути отладочную плату

без установленных элементов, но с

большими макетными полями и разъ�

ёмами под мезонинную установку де�

монстрационной платы (см. рис. 3). Те�

перь пользователь сможет обойтись

минимально необходимым числом до�

полнительных элементов, разместив

их на плате прототипа.

После завершения исследования

выбранной концепции пользователь

LPCXpresso может перейти к стадии

разработки (develop) своего приложе�

ния путём отладки кода с помощью

JTAG�отладчика LPC�Link, подключае�

мого к плате через десятиштырьковый

разъём JTAG (J5 на рис. 1, в красном

круге). Ответная часть этого разъёма

может быть предусмотрена на любой

заказной плате конечной системы.

Кроме того, отладка может произво�

диться в МК демонстрационной пла�

ты, установленной на прототип.

Таким образом, один и тот же по су�

ти, бесплатный пользовательский ин�

терфейс и недорогой инструментарий

могут применяться на всех этапах раз�

работки и отладки конечного изделия.

АППАРАТНЫЕ

ИНСТРУМЕНТАЛЬНЫЕ

СРЕДСТВА LPCXPRESSO

Аппаратные средства разработки и

отладки LPCXpresso (демонстрацион�

ные платы) производятся NXP в парт�

нёрстве с фирмами Embedded Artists

и Code Red Technologies и выпускаются

на базе МК семейств LPC3xxx, LPC2xxx,

LPC17xx, LPC13xx и LPC11xx. Интегри�

рованный USB�JTAG/SWD�отладчик

LPC�Link может использоваться как в

МК из состава «своей» платы, так и в

МК из состава внешней системы. В пер�

вом случае подключение к МК реализо�

вано через проводники печатной пла�

ты LPCXpresso, выполненные между

парами близкорасположенных отве�

рстий на шине JTAG/SWD и размещён�

ные на плате между областью отладчи�

ка LPC�Link и областью целевого МК

(разъём J4 на рис. 1).

Во втором случае подключение мо�

жет быть реализовано гибкими про�

водниками через миниатюрный деся�

тиштырьковый разъём JTAG/SWD (J5

на рис. 1), расположенный на демон�

страционной плате в области отладчи�

ка. При использовании отладчика LPC�

Link с внешним МК, подключение к МК

из состава «своей» платы должно быть

разорвано путём перерезания дорожек

между парами близкорасположенных

отверстий. Чтобы сохранить возмож�

ность восстановления подключения в

дальнейшем, производитель рекомен�

дует установить на весь ряд пар отверс�

тий разъём 2 × 8, выводы которого при

необходимости могут быть замкнуты

стандартными перемычками.

Отладчик LPC�Link поддерживает це�

левые МК от NXP с процессорными

ядрами Cortex�M0, Cortex�M3, а так�

же ARM7/9 (МК семейств LPC17xx,

LPC13xx, ряд МК семейства LPC11xx

и некоторые представители МК се�

мейств LPC2000 и LPC3000). Сам отлад�

чик LPC�Link аппаратно выполнен на

базе МК LPC3154 от NXP с ядром ARM9.

Таким образом, демонстрационные

платы LPCXpresso могут использовать�

ся следующим образом:

● автономно (в качестве отладчика и с

собственным МК) для разработки

программного обеспечения и его

тестирования в «железе»;

● в качестве отладчика и с собствен�

ным МК вместе с базовой платой,

например, для быстрого исследова�

ния выбранной концепции прило�

жения;

● в качестве отладчика и с собствен�

ным МК вместе с платой прототипа

как целевой системы;

● только в качестве отладчика для МК

внешней системы.
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Рис. 1. Демонстрационная плата LPCXpresso с интегрированным USB�JTAG/SWD�отладчиком LPC�Link

Рис. 2. Базовая отладочная плата (Base Board) Рис. 3. Плата прототипа (Prototype Board)

© СТА�ПРЕСС



ПРОГРАММНЫЕ

ИНСТРУМЕНТАЛЬНЫЕ

СРЕДСТВА LPCXPRESSO

В качестве средства программной

поддержки демонстрационных плат

LPCXpresso фирма NXP предлагает ин�

тегрированную среду разработки и от�

ладки LPCXpresso IDE, разработанную

и поддерживаемую фирмой Code Red

Technologies. Этот продукт включает в

себя все инструментальные средства,

необходимые для разработки встроен�

ного программного обеспечения на

базе МК семейства LPC1xxx.

В приведённом ниже описании

LPCXpresso IDE использовалась инфор�

мация, полученная автором в ходе прак�

тической работы с IDE, сведения из

контекстной справки этого продукта

(LPCXpresso IDE Help > Help Contents), а

также материалы [2]. В силу ограничен�

ного объёма статьи здесь изложены

только основные сведения о LPCXpresso

IDE. Для получения более подробной

информации рекомендуется обратить�

ся к [3].

В состав LPCXpresso IDE входят:

собственно среда разработки и отладки

на основе Eclipse, компилятор GNU С,

набор библиотек, компоновщик, а так�

же усовершенствованный отладчик

GDB, обеспечивающие профессио�

нальное качество кода с несколькими

уровнями его оптимизации.

Среда LPCXpresso IDE поддерживает

возможности, связанные с обработкой

исходного кода на языке C, такие как

выделение синтаксиса, форматирова�

ние исходного текста, сворачивание

функций, прямые ссылки на опреде�

ления и объявления функций.

На момент написания статьи версия

платформы LPCXpresso поддерживала

следующие МК семейства LPC:

● все МК семейства LPC11xx;

● все МК семейства LPC13xx;

● МК семейства LPC17xx: LPC1751,

LPC1752, LPC1754, LPC1756, LPC1758,

LPC1764, LPC1765, LPC1766, LPC1767,

LPC1768;

● МК семейства LPC2xxx: LPC2109,

LPC2134, LPC2142, LPC2362, LPC2929;

● МК семейства LPC3xxx: LPC3130,

LPC3250.

Среда LPCXpresso IDE поддерживает

работу с JTAG�отладчиком LPC�Link от

NXP, а также с JTAG�адаптером Red

Probe от Code Red Technologies. Для об�

легчения работы с демонстрационны�

ми платами в комплект LPCXpresso IDE

включены примеры готовых проектов

и справочная документация по ним.

После инсталляции LPCXpresso IDE

эти примеры находятся в папке nxp\

lpcxpresso\Examples.

Файл дистрибутива LPCXpresso мо�

жет быть бесплатно загружен по адре�

су http://lpcxpresso.code�red�tech.com/

LPCXpresso после ввода логина и паро�

ля, полученных по электронной почте

при регистрации на той же интернет�

странице.

После инсталляции на ПК программ�

ный продукт LPCXpresso необходимо

активировать. При первом запуске

программы в окне рабочей облас�

ти LPCXpresso IDE открывается окно

встроенного браузера с предупрежде�

нием Please note: Your product is not

activated. В этом же окне находится

инструкция по активации.

Для активации необходимо обеспе�

чить соединение ПК с Интернет, затем

выбрать в главном меню LPCXpresso

IDE Help > Product activation > Create

Serial number and Activate для генера�

ции уникального серийного номера

продукта, после чего ввести в откры�

вающуюся по заданной в инструкции

ссылке сетевую форму указанный се�

рийный номер, который основан на

конфигурации аппаратных средств и

ОС ПК и не содержит никакой личной

информации.

После завершения заполнения фор�

мы и щелчка на кнопке Send me my

activation code пользователь получает

код активации на указанный им при

регистрации адрес электронной поч�

ты. Этот код необходимо вставить в

диалоговое окно активации продукта,

отрываемого путём выбора в главном

меню LPCXpresso IDE Help > Product

activation > Enter activation code. В слу�

чае корректно проведённой процеду�

ры появляется сообщение, подтверж�

дающие принятие кода активации.

После завершения процедуры акти�

вации окно приглашения при запуске

программы будет содержать надпись

LPCXpresso is fully activated вместе со

ссылками на доступные локальные и

сетевые информационные ресурсы

LPCXpresso.

СТРУКТУРА И КОМПОНЕНТЫ

LPCXPRESSO IDE
При работе в LPCXpresso IDE исполь�

зуется понятие рабочей области

(Workbench). Каждая рабочая область

содержит одну или более перспектив

(Perspective). Перспективы представ�

ляют собой определённую конфигура�

цию окон обозрений (View) и редак�

торов (Editor), доступ к которым воз�

можен через соответствующие меню

и инструментальные панели, и ото�

бражают специфические представле�

ния данных в LPCXpresso. Это может

быть исходный текст, hex�дамп, дизас�

семблированный текст, содержимое

памяти и т.п. Окна обозрений и редак�

торов в пределах перспективы могут

быть открыты, перемещены, состыко�

ваны и закрыты пользователем. Поль�

зователь может изменять размещение

перспективы, открывая и закрывая

обозрения и закрепляя их в пределах

рабочей области. Размещение отобра�

жаемых в текущий момент окон обо�

зрений и редакторов может быть со�

хранено и затем восстановлено поль�

зователем.

Обозрения поддерживают редак�

торы и обеспечивают способы управ�

ления информацией в рабочих облас�

тях. Например, проводник проектов

(Project Explorer) и другие навигацион�

ные обозрения управляют отображе�

нием проектов и других ресурсов,

с которыми работает пользователь.

Обозрения также имеют свои собствен�

ные меню. Чтобы сделать меню види�

мым, следует кликнуть на пиктограм�

ме в левой части области заголовка

обозрения. Некоторые обозрения име�

ют свои собственные инструменталь�

ные панели.

Для проектов, папок и файлов,

которые находятся в рабочей облас�

ти, введён собирательный термин

«ресурсы». Навигационные обозре�

ния обеспечивают иерархическое

представление ресурсов и позволя�

ют открывать их для редактирова�

ния. Другие инструментальные сред�

ства могут иначе отображать и обра�

батывать эти ресурсы. Каждому типу

ресурсов, существующему в рабочей

области, сопоставляется определён�

ный тип объектов из файловой сис�

темы ПК:

● файлам сопоставляется файлы;

● папкам сопоставляются каталоги

в файловой системе. В рабочей об�

ласти папки содержатся в проектах

или в других папках. Папки могут со�

держать файлы и другие папки;

● проекты содержат папки и файлы.

Проекты используются для ком�

поновки, управления, совместного

использования и организации ре�

сурсов. Подобно папкам, проекты со�

поставляются каталогам в файловой

системе. Когда пользователь создаёт

проект, он определяет местоположе�

ПРОГРАММИРОВАНИЕ

70 WWW.SOEL.RU СОВРЕМЕННАЯ ЭЛЕКТРОНИКА ◆ № 5  2011© СТА�ПРЕСС



ние этого проекта в виде каталога в

файловой системе.

Папки и файлы могут быть размеще�

ны в файловой системе вне местополо�

жения проекта. Тогда они называются

связанными ресурсами.

Перспектива, как уже было сказано,

представляет собой определённую

конфигурацию обозрений и редакто�

ров; она определяет начальный набор

и размещение обозрений в окне ра�

бочей области. В пределах окна каж�

дая перспектива совместно использу�

ет один и тот же набор редакторов.

Каждая перспектива предоставляет

разработчику набор функциональ�

ных возможностей, нацеленных на

выполнение определённого типа за�

дач, или работает с определёнными

типами ресурсов. Например, перспек�

тива разработки Develop объединяет

обозрения, которые обычно исполь�

зуются при создании (импортирова�

нии) проектов, а также создании и

редактировании исходных файлов.

Перспектива Debug содержит обозре�

ния, которые обычно используются

при отладке кода. При работе с одним

и тем же проектом в рабочей области

пользователь может переключать

перспективы.

Все обозрения в перспективе мо�

гут быть перемещены пользователем

путём их перетаскивания. Если обозре�

ние было случайно закрыто, то оно мо�

жет быть восстановлено путём его вы�

бора в главном меню (меню перспек�

тивы) Window > Show View > (Other...) >.

При этом открывается диалоговое

окно Show View, содержащее все имею�

щиеся обозрения.

Перспективы могут содержать собст�

венные меню и инструментальные па�

нели. Они определяют видимые набо�

ры действий, которые разработчик мо�

жет использовать, чтобы настроить

перспективу. Для открытия требуемой

перспективы в окне рабочей области

следует выбрать в меню Window > Open

Perspective. Чтобы увидеть список всех

поддерживаемых перспектив, следует

выбрать Window > Open Perspective >

> (Other...) >, после чего откроется окно

Open Perspective.

Большинство перспектив в рабочей

области состоит из области редактора

и одного или более обозрений. Поль�

зователь может связать определённый

редактор с определёнными типами

файлов. Например, когда пользователь

открывает файл для редактирования,

дважды кликнув на его названии в

одном из навигационных обозрений,

окно связанного с этим файлом редак�

тора автоматически открывается в ра�

бочей области.

В каждый момент времени может

быть открыто любое количество

редакторов, но только один из них

может быть активен. (На самом деле

в LPCXpresso IDE имеется только

один многооконный редкатор.) При

этом область главного меню и инст�

рументальная панель окна рабочей

области содержат команды и пикто�

граммы операций, соответствующих

активному редактору. Позиции та�

буляции в области редактора ука�

зывают названия ресурсов, которые

в настоящее время открыты для ре�

дактирования. Звездочка (*) у назва�

ния ресурса указывает, что редактор

ещё не сохранил произведённые из�

менения.

Поле слева от границы области

редактирования в окне файла может

содержать значки, которые помечают

ошибки, предупреждения или пробле�

мы, обнаруженные инструменталь�

ными средствами LPCXpresso IDE при

обработке редактируемых ресурсов.

Значки также появляются при созда�

нии закладок, добавления точек оста�

нова в коде или зарегистрированных

примечаний.

Для обеспечения возможности со�

здавать, редактировать, компилиро�

вать, компоновать и отлаживать при�

ложения в составе среды LPCXpresso

IDE должен быть установлен набор

инструментов разработки C/C++ –

C/C++ Development Toolkit (CDT). По

умолчанию в состав CDT LPCXpresso

IDE уже входит инструментарий Code

Red MCU Tools. Заметим, что вхо�

дящий в CDT альтернативный инст�

рументарий может быть как коммер�

ческим (платным), так и отрытым

(бесплатным), например, от GNU.

К последней категории относится

инструментарий GNU toolchain, со�

держащий утилиты компоновщика,

GCC�компилятора и GDB�отладчика.

Как указано в контекстной справ�

ке LPCXpresso IDE, в случае ис�

пользования разработчиком ПК

под ОС Windows для загрузки GNU

toolchain можно использовать один

из двух интернет�ресурсов: MinGW

(www.mingw.org) и Cygwin (www.cyg�

win.com).

Загрузку ПО GNU toolchain с ресурса

MinGW рекомендуется осуществлять в

следующем порядке:

● загрузить и выполнить программу

установки MinGW�5.1.3.exe (http://

d o w n l o a d s . s o u r c e f o r g e . n e t /

mingw/MinGW�5.1.3.exe). По умол�

чанию при запуске предлагается

установка программы в корневой ка�

талог MinGW на диске ПК. При этом

следует выбрать загрузку и установку

базового инструментария MinGW и

g++�компилятора. Можно также вы�

брать загрузку и других компиля�

торов. Выбор установки утилиты

MinGW Make не рекомендуется;

● программа установки MinGW в на�

стоящее время автоматически не

устанавливает gdb�отладчик. Что�

бы установить отладчик вручную,

необходимо загрузить файл gdb�

6.6.tar.bz2 (http://downloads.source�

forge.net/mingw/gdb�6.6.tar.bz2),

затем с помощью стандартной про�

граммы архиватора распаковать

этот файл и поместить его в папку,

где находится MinGW;

● если разработчик хочет использовать

makefile�проекты (см. ниже), то ему

необходимо загрузить и выполнить

соответствующую программу уста�

новки MSYS�1.0.10.exe (http://down�

loads.sourceforge.net/ mingw/MSYS�

1.0.10.exe). По умолчанию при за�

пуске этого файла предлагается

установить программу в корневой

каталог msys на диске ПК. Програм�

ма MSYS обеспечивает для формиро�

вания проектов соответствующие

инструментальные средства команд�

ной строки. Заметим, что её исполь�

зование не требуется для других ти�

пов проектов, подготовленных с по�

мощью MinGW toolchain.

Страница интернет�ресурса MinGW,

переход на которую осуществляется

по гиперссылке из раздела контекст�

ной справки Help LPCXpresso IDE, от�

крывается в окне обозрения встроен�

ного навигатора LPCXpresso IDE.

Продолжение следует
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